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1 Scheme Editor
The Scheme Editor is a desktop application for the creation of hydraulic and
pneumatic diagrams in compliance with standards. On the basis of a hydraul‐
ic and pneumatic symbol library, it is easily possible to also prepare complex
diagrams. Additional libraries can be added. Material numbers, item numbers
and accessory can be assigned to diagram components so that it is possible
to generate a parts list on the basis of this model.
By means of graphical objects like e.g. line, circle and rectangle with many
possible settings for colors and types, the diagram can be extended by indi‐
vidual requirements. For an easier navigation, each object can be assigned a
hyperlink to further documents. Apart from that, each sheet can be assigned
a title block with defined input fields.
The Scheme Editor software can be operated intuitively and does not presup‐
pose special CAD knowledge. It can be used at the customer, in the sales, in
the technical indoor service or in the application center. This manual de‐
scribes the functional scope of the application and thus allows you a quick
start. The order of the individual chapters corresponds to the standard work‐
flow in the creation of a diagram.

Fig. 1-1: The user interface of the Scheme Editor application
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2 Description of the User Interface
2.1 General

This section explains the user interface, its individual components and the
toolbars. In this section you learn how to design the program window accord‐
ing to your requirements by docking and undocking the different windows.
The terms used in this section will also be used in the whole documentation.

2.2 Main Window
The main window is the desktop of the program. Its size and position can be
changed. For many other interface elements (e.g. menu bar, toolbars, "dock‐
able" windows), the main window can be regarded as a kind of "frame". With‐
in the main window, these elements can be attached to the window edges.

Size adjustment
The change in the size of the main window is visualized by three dotted
slashes at the lower right edge . In the maximized view of the main win‐
dow, the slashes are not shown. For this purpose, the window must be mini‐
mized, e.g. using the  button in the title bar. The size of the window can be
changed by positioning the mouse pointer on the window frame area and
dragging the window frame to the left / right or upwards / downwards while
keeping the left mouse button pressed.

Fig. 2-1: Scaling the main window using the window frame

2.3 Title Bar
The horizontal bar at the upper edge of a Windows application is called title
bar. It contains the program symbol with the system menu, the program
name and the pushbuttons for the size (minimize, restore or maximize) as
well as the symbol for exiting the program.

Fig. 2-2: Title bar

2.4 Program Window
2.4.1 Areas of the Program Window

The program window is divided into the following areas:
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Fig. 2-3: The program window of the Scheme Editor application
1. Model explorer
In the model explorer, the opened model with the related sheets and compo‐
nents is shown in a structured form. It is used for navigating in the model and
for executing different commands.

2. Model view
The model view document window represents the connection scheme. For
creating the scheme, components from the library can be dragged into the
model view by means of Drag&Drop and connections between the compo‐
nents can be established.

3. Library
In the library, all domains that can be used for the connection scheme crea‐
tion are listed. By selecting a domain, the components contained therein are
shown in the component preview (4) situated below.

4. Component preview
In the component preview, the components of the selected domain are
shown.

5. Parts list
The parts list shows a list of the components and accessories used as table.

6. Properties
The properties window allows for the processing of the properties of selected
components. Identification code designation, material and item number can
be processed.

2.4.2 Showing and Hiding Areas
The individual areas can be shown and hidden via the menu item View from
the main menu.
The "model view" window cannot be hidden. If all opened worksheets are
closed, the area is shown in gray.
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2.5 Toolbars
2.5.1 General Information on Toolbars

By default, the toolbars are located below the menu bar and consist of push‐
buttons by means of which the most important functions can be called. If the
mouse pointer rests over a symbol for some seconds, its meaning is shown
by means of a tooltip.

Fig. 2-4: The toolbar of the application
The symbols in the toolbar are shown in gray if they are not available due to
the current processing step.
Hiding and showing toolbars:
Toolbars that are not required can be hidden. Clicking on a free area in the
menu bar or toolbar using the right mouse button opens a context menu.

Fig. 2-5: Showing and hiding toolbars via the context menu
The context menu shows all available toolbars. Shown toolbars are marked
by a preceding checkmark. The toolbars can be shown or hidden by setting
the checkmark.

2.5.2 Standard Toolbar
The standard toolbar allows for simple commands like the creation of a new
model, saving, copying or cutting.

Fig. 2-6: Standard Toolbar
The function of the symbols (from left to right):

●  New Model

●  Open Model

●  Save

●  Save All

●  Print
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●  Print Preview

●  Cut

●  Copy

●  Paste

●  Undo

●  Redo

●  Edit Hyperlink

●  Delete Hyperlink

●  Open Hyperlink

2.5.3 Layout Toolbar
In the layout toolbar you can, for example, show or hid the grid or the ruler
and edit the size and position of components.

Fig. 2-7: Layout Toolbar
The function of the symbols (from left to right):

●  Align Lefts

●  Align Centers

●  Align Rights

●  Align Tops

●  Align Middles

●  Align Bottoms

●  Make Same Width

●  Make Same Height

●  Make Same Size

●  Flip Horizontal

●  Flip Vertical

●  Rotate Right

●  Rotate Left

●  Align to Grid
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●  Align to Objects

●  Bring to Front

●  Send to Back

●  Show/Hide Major Grid

●  Show/Hide Ruler

2.5.4 Zooming Toolbar
Settings for zooming the worksheet are made in the zooming toolbar.

Fig. 2-8: Zooming Toolbar
The function of the symbols (from left to right):

●  Hand Tool

●  Selection Tool

●  Partial Zoom

●  Dynamic Zoom

●  Zoom Out

●  Zoom In

●  Zoom Values

●  Original Size

●  Window Height

●  Window Width

●  Zoom Whole Page

2.5.5 Format Toolbar
Using the format toolbar, settings for tests are made, like e.g. font type and
type face. Here, you can also select the fill and line colors.

Fig. 2-9: Format Toolbar
The function of the symbols (from left to right):

●  Font Color

●  Font and Size

●  Bold
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●  Italic

●  Underlined

●  Underlined

●  Left-aligned

●  Centered

●  Right-aligned

●  Line Color

●  Line Strength

●  Line Type

●  Fill Color

2.5.6 Drawing Toolbar
This toolbar includes the functions for free drawing.

Fig. 2-10: Drawing Toolbar
The function of the symbols (from left to right):

●  Adds a Free Text

●  Adds a Text Box

●  Adds a Line

●  Adds a Polyline

●  Adds a Polygon

●  Adds an Ellipse

●  Adds a Rectangle

● Adds an Elliptical Arch

● Adds an Ellipctical Pie

2.6 Adjusting the Program Window
2.6.1 Resetting the Program Window

The alignment of the main menu, the toolbars and tool windows can be reset
at any time in the option dialog that is accessible via the main menu item
Tools ▶ Options, by means of the buttonsReset main menu and toolbars and
Reset tool windows .
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2.6.2 Docking
The work environment can be adjusted to your working habits. Many win‐
dows that are frequently required for processing data can be permanently
positioned in the program window while working.

Fig. 2-11: Docking the independent properties window to the program window
The following steps must be completed for docking a window:

1. Place the mouse pointer on the title bar
2. Press the left mouse button and keep it pressed
3. Drag the mouse button with the attached window to the desired place in

the program window
4. Select the desired docking mode by placing the mouse pointer on the

pictogram (the following modes are available: upper, lower, left and right
window frame as well as docking as tab)

5. Release the mouse button
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2.6.3 Undocking
Docked windows can be released from the program window and be placed
as independent window next to the program window on the desktop or on a
second monitor, if applicable.

Fig. 2-12: Undocking for the properties window and placing on a freely selecta‐
ble place of the desktop

The following steps must be completed for undocking a window:
1. Place the mouse pointer on the title bar
2. Press the left mouse button and keep it pressed
3. Drag the mouse button with the attached window to the desired place of

the desktop
4. Release the mouse button

2.6.4 Automatic Hiding
Another possibility for adjusting the program window to one's own require‐
ments is offered by the automatic hiding of program windows as it is, for ex‐
ample, known from the Windows task bar. Windows hidden in that way are
shown as pictograms at the program window frame to which they are docked.
If the mouse pointer is placed on the pictogram, the window is shown as long
as the cursor is within the shown window and automatically hidden as soon
as the cursor leaves the window. In this way, the place for the model view
can be enlarged in a very effective way.
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By default, the automatic hiding of a window is deactivated. This is shown by
the vertical pin in the right corner of the window title bar:

Fig. 2-13: Automatic hiding is switched off
Automatic hiding is switched on by clicking on the pin. The pin then changes
into a horizontal orientation, the program window is closed and shown as pic‐
togram at the edge of the display:

Fig. 2-14: Automatic hiding activated
If you now move the mouse over the pictogram at the edge of the display, the
window is shown:
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Fig. 2-15: When moving over the pictogram, the hidden window is shown
Now, you can work with the window. If the mouse leaves the window, it is hid‐
den again.

2.6.5 Window Alignment
If two or more windows are opened, they can be aligned vertically next to
each other or horizontally above each other. The starting point of the action is
the context menu of the tab of the window that is to be re-aligned.
If the windows are to be shown vertically next to each other, the New Vertical
Tab Group is to be selected, for a horizontal alignment, select New Horizontal
Tab Group.

Fig. 2-16: The second model view is to be aligned next to the first model view.
After executing the command, the window is shown next to the first window.
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Fig. 2-17: The second worksheet is shown vertically next to the first worksheet.
The currently active document window is marked by the name in the tab writ‐
ten in bold. If now, new windows are opened, they are opened in the active
document window and a new tab is created for the new window.
In this way, the document windows can be divided as often as required - the
only limiting factor is clarity. The document window that has just been created
can, for example, firstly be divided horizontally, and then vertically again.

Fig. 2-18: The division of the document windows can be nested arbitrarily. Win‐
dows can be moved from one document window into another one by
means of Drag&Drop.

Via their tab, the windows of a document window can be moved from one
document window into another one by means of Drag&Drop. If the last model
view of a document window is moved into another one, the empty document
window will be closed. In the preceding example, the document window con‐
taining the model view "Sheet (4)" is, for example, closed after the latter has
been moved so that the document window with the model view "Sheet (2)"
takes the free space.
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An other possibility to move a document window is provided in the tab con‐
text menu. By using the context menu entry Move to Previous Tab Group the
window is moved to the left tab group. This possibility is also provided for hor‐
izontal tab groups.

Fig. 2-19: Using the context menu to move a window to another tab group.
The context menu entryClose closes the window. The entry Close All Except
This One closes all windows except the one you started the command.

2.7 Extern Shortcuts
2.7.1 General

Linkages with external references can be made to frequently used programs,
files or web pages. These links are accessible via the main Tools menu.

Fig. 2-20: The configurable extern shortcuts provide quick access to frequently
used applications, files or web sites.

2.7.2 Configure Extern Shortcuts
The Extern Shortcuts can be adapted to your personal need via the main
menu Tools ▶ Extern Shortcuts....
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Fig. 2-21: The Extern Shortcuts can be adapted to your personal need via the
main menu.

The toolbar in the dialog provides the possibility to (from left to right):
● create a new shortcut
● delete a shortcut
● edit a shortcut
● change the shortcut display order
By clicking in the list control you can create a new shortcut using the context
menu entry New, and existing shortcuts can be deleted by their context menu
entry Delete or edited via Properties.... The dialog for editing shortcut proper‐
ties is the same as for creating a new shortcut.

2.7.3 Create Shortcut
File

To create a shortcut for a file click the button File, enter a display text which
is displayed in the Tools menu and select the file with the button ... .
Click OK to create the shortcut.

Fig. 2-22: File shortcut

Website
To create a shortcut for a website click the button Website, enter a display
text which is displayed in the Tools menu and enter the web site address.
Click OK to create the shortcut.
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Fig. 2-23: Website shortcut

Application
To create a shortcut for a application click the button Application, enter a dis‐
play text which is displayed in the Tools menu and select the application exe‐
cutable via the button ... .
Enter the working directory and provide command line arguments needed to
start the application.
Click OK to create the shortcut.

Fig. 2-24: Application shortcut
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3 Library
3.1 General

The Symbol Library contains the libraries. This libraries contain the symbols
necessary for creating the model. In the upper area, the libraries with their
different domains and subdomains are listed; after selection, the components
contained therein are shown in the lower area with symbol and designation.
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Fig. 3-1: The Symbol Library with the libraries and components
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3.2 Selection of Components
The components of the library can be dragged to the model view or, in the
model explorer, to a sheet by means of Drag&Drop.

Fig. 3-2: Using a component by means of Drag&Drop
If the component is dragged to the model view, it is placed at the point where
the mouse button is released.
If the component is dragged to a sheet in the model explorer, the component
is placed in the left top corner of the sheet.
The library supports the multiple-selection of components. For selective multi‐
ple-selection, keep the <CTRL> key pressed when selecting the components.
For a from-to area selection, keep the <SHIFT> key pressed and select the
first and then the last component of the area; all components in between will
be selected, as well.
The multiple-selection can be dragged to the model view or a sheet in the
model explorer by means of Drag&Drop. In this connection, the components
are placed over each other.

3.3 Searching Components
The library has a search function by means of which components can be
easily found on the basis of their name. The search with the search term
"directional", for example, will find all components with the term directions in
their name.
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Fig. 3-3: Search for components

Bosch Rexroth AG  Print24/119
Scheme Editor Version 6.3

Library



1. Select the search criteria
2. Select where the search should be performed
3. Enter the search term
4. Search options: match case, search only whole word
5. Search results are displayed in lower section

Similar to the library, the found components can be dragged from the search
results window to the model view or a sheet in the model explorer by means
of Drag&Drop, whereas multiple-selection is possible here, as well. Double-
click on the component selects the component in the library and marks the
superior domain and subdomain, if applicable.

3.4 Searching Material
If the library is searched by material numbers or material designation, a differ‐
ent presentation of the search result is shown.
In this mode two Drag & Drop possibilities exist:

1. Drag & Drop of a symbol will put the symbol on the drawing area without
any material numbers or material designation.

2. Drag & Drop of a material number will put the symbol with the selected
material number and material designation on the drawing area

Fig. 3-4: Drag & Drop of symbols or material numbers using the search result
window of material based searches

3.5 Model and Recent Used Symbols
By clicking the icon Recent symbols you will get a list of all symbols recently
used:
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Fig. 3-5: Recent symbols
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By clicking the icon Model symbols you will get a list of all symbols used in
your current model:

Print Bosch Rexroth AG 27/119
Scheme Editor Version 6.3

Library



Fig. 3-6: Model symbols
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You can add the symbols to your model using Drag & Drop.

3.6 Accessories
The accessory component is the representative for any accessory that is to
be listed in the parts list, however, not to appear on the model.
Like any other component, the accessory is dragged to the model view or the
model explorer by means of Drag&Drop and placed there. After pasting, a
short pop-up window notifies the pasting process; now, the accessory is
available in the model explorer under accessories.
If the accessory is placed on a sheet, it will be listed in the Model Explorer as
accessory of the sheet. If it is placed on a symbol, it will be listed as accesso‐
ry of the symbol.

Fig. 3-7: After Drag&Drop of the accessory component it is listed in the model
explorer under accessories and can be edited in the properties win‐
dow.

The Properties context menu of the accessory in the model explorer or - if the
properties window is already open - the selection in the model explorer is
used for editing the accessory properties. For more information seechapter
5.5  "Properties Dialog" on page 70 and chapter 4  "Model Explorer" on
page 41.

3.7 Import Library
The Scheme Editor Symbol Library allows the import of other Scheme Editors
libraries.

1. Click on Import... in the Symbol Library
2. Select the library file and click on Open to start the import
3. After the import the new library can be used
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Fig. 3-8: Importing a Scheme Editor library

Scheme Editor does not need the library file anymore after im‐
porting it.

3.8 Export Library
The Scheme Editor Symbol Library allows the export of each library.
An exported library can be set read-only so this library can't be changed by
users.

1. Right-Click on library
2. Select Export...
3. Set read-only state, name, designation DE and EN, version, color and

creator
4. step to next page
5. edit the library description and click Next
6. edit library signature
7. select file path and enter file name after clicking on OK and start export

by clicking Save

Fig. 3-9: Export any library, set read-only state, color, name, creator and des‐
ignation
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Fig. 3-10: Edit library description
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Fig. 3-11: Edit library signature

3.9 Create Library
The Scheme Editor provides the creation of new libraries.

1. Click on New... in the Symbol Library
2. Enter the name of the library
3. Enter the German and English designation of the library. This will be‐

come the display name in the Symbol Library.
4. Enter description and signature
5. Set version, color und creator
6. Create library by clicking on OK

Bosch Rexroth AG  Print32/119
Scheme Editor Version 6.3

Library



Fig. 3-12: Create new library

A new library created by you will be read-only by default.

3.10 Edit Library
You can change an editable library as described here.
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Fig. 3-13: Edit library
Library context menu (1):
● New Folder - creates a new top level folder (check 1, 2 or 3)
● Delete - deletes the library
● Edit... - opens the dialog to edit library name, version, creator, signature,

color, ...
● Export... - exports the library
Library folder context menu (2):
● New Folder - creates a subfolder below the current selected folder

(check 2.1 or 2.2)
● Cut - cuts the folder and all its symbols and copies it into the clipboard
● Copy - copies the folder and all its symbols into the clipboard
● Paste - copies the clipboard content into this position
● Delete - deletes the folder, its subfolders and all its symbols
● Rename - opens a dialog to rename the folder
● Import... - opens the dialog to import objects to this position

3.11 Copy Symbols
Library symbols can be copied on various ways.
Drag & Drop
Any symbol of any library can be copied into an other, editable library using
Drag & Drop.
● Bring the symbol to be copied to display
● Bring the target folder to display by scrolling the Symbol Library
● Drag & Drop the symbol out of the symbol view into the target folder
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Fig. 3-14: Copy a symbol to an other library by Drag & Drop
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If the target folder is in the same library as the symbol, the symbol
is moved and not copied to the new location

Context Menu
By copying symbols using the context menu commandos copy (<Ctrl>+<C>)
and paste (<Ctrl>+<V>) symbols can be copied into folders of other libraries
and also be copied to a new folder in the same library. The paste commando
can be performed directly on a library folder or the symbol view.

Fig. 3-15: Copy symbol using copy and paste operation

3.12 Import and Export Symbols
Any symbol can be exported. Importing a symbol is only possible into libra‐
ries that are editable.
To export a symbol, right-click on the symbol in the library and select the con‐
text menu commando Export. After that select a file location where to export
the symbol.
This symbol can be edited with the chapter 12  "Symbol Modeling Tool" on
page 111 which is installed together with the Scheme Editor and can be im‐
ported into an editable library.
To import a symbol, right-click on the target folder of an editable library and
select the context menu commando Import. Now a file open dialog appears
where you can select the symbol file to import.

3.13 Product Catalog
The Aventics Pneumatic product catalog allows you to transfer components
to the Scheme Editor. You can find the product catalog here: http://
www.aventics.com/pneumatics-catalog/.
Open the product catalog, navigate to the desired component and select the
desired variant.
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Fig. 3-16: Select the component in the Aventics Pneumatic product catalog
Scroll down the page until you see the material numbers. Click on the materi‐
al number you need and select the context menu entry D&C Scheme Editor .

Fig. 3-17: Click on the material number to transfer it to Scheme Editor
The Scheme Editor shows you the symbol in the symbol view from where you
can Drag & Drop it into the model view.
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Fig. 3-18: Drag & Drop the symbol into the model view

3.14 ICS Configurator - Send Circuit Diagram to Scheme Editor
The Aventics configurator enables you to send system circuits to Scheme Ed‐
itor. In the configurator, click on Circuit diagram on the right navigation pane.

The Scheme Editor must be started and a project with a sheet
must be available. No Scheme Editor dialogs as for example the
Options dialog must be opened. Otherwise the circuit can not be
send to Scheme Editor.

Fig. 3-19: In the configurator click on Circuit diagram
On the following page, click on Send to D&C Scheme Editor. This starts the
download on you local PC.
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Fig. 3-20: Click on Send to D&C Scheme Editor to send the circuit diagram
The following steps depend on the internet browser and security settings you
are using. The Microsoft Internet Explorer offers you the possibility to directly
open the download. Other browsers save the file to a directory where you
must open it.

Fig. 3-21: Open the download to import the circuit as vector graphics into the
current sheet.

After opening the download the circuit will be imported as vector graphics into
the current sheet.
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Fig. 3-22: After opening the download the circuit will be imported as vector
graphics into the current sheet.
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4 Model Explorer
4.1 General

In the model explorer, all opened models with their sheets and components
are shown below the project node in a tree structure. The context menu of
the model explorer offers the following:
● Context menu at free area of model explorer

– New Model
– Open Model...
– Import...

● Context menu model
– Open Parts List
– Open User Defined Fields
– New Sheet
– Export...
– Import...
– Publish As PDF...
– Close Model
– Properties

● Context menu sheet
– Open Sheet
– Open Parts List
– Open User Defined Fields
– Export...
– Select All
– Cut
– Copy
– Delete
– Duplicate
– Rename
– Properties

● Context menu component
– Open Parts List
– Open User Defined Fields
– Export...
– Select All
– Cut
– Copy
– Delete
– Duplicate
– Hyperlink
– Rename
– Properties
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● Context menu accessories
– Open Parts List
– Open User Defined Fields
– Add Accessories
– Select All
– Delete
– Rename
– Properties

● Context menu accessory position
– Open Parts List
– Open User Defined Fields
– Edit...
– Select All
– Cut
– Copy
– Delete
– Duplicate
– Hyperlink
– Rename
– Properties

Fig. 4-1: Model explorer with model, sheets, components and accessories
Further functionality depends on the current application state.

4.2 Operation
4.2.1 General Functions
Create New Model

In order to create a new model, select the context menu item New Model
from the context menu of the project explorer. A new model with ascending
numbering is created. The model automatically contains a new "sheet (1)"
that is displayed, as well.
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Open Model
Using the Open Model... function, a model stored on data carriers or network
drives can be opened. The function can be accessed from the context menu

of the model explorer, the main menu File ▶ Open Model... or the  toolbar
icon. After selection of the menu item, the added model can be selected in a
file dialog.

Close Model
The model can be closed using the Close model menu item whereas the re‐
spective model name is shown instead of the model. If since it has been
saved for the last time, the model has been changed, the user can choose in
an automatically appearing dialog whether the changes are to be saved or re‐
jected or if closing of the model is to be canceled.

Create New Sheet
The number of sheets managed by one model is unlimited. In order to create
a new sheet for a model, select the menu item New sheet from the context
menu. A new sheet is created and displayed.

Searching
The model explorer offers a search function by means of which you can
search for an element in the model explorer. As search criterion, the name or
only a part of the name is used. If the search criterion applies to several ele‐
ments, the next hit is highlighted by actuating the search button once again.
If the hit is a component the model view of which is open for editing, the com‐
ponent is marked in the model explorer and in the model view.

1. Enter the search term
2. Start the search by clicking the search icon
3. Hit is marked in the model explorer
4. By clicking the search icon again, the next hit is marked

Fig. 4-2: Search function of the model explorer

Opening Sheets and Components
Sheets can be displayed using the Open Sheet context menu item or by dou‐
ble-clicking on the sheet in the model explorer in the model view.
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By double-clicking on a component in the model explorer, the related sheet is
opened. The component is marked in the model view and the sheet is dis‐
placed, if necessary, so that with large sheets, the component is shown in the
visible area.

Renaming Elements
Renaming of an element can be initiated in 3 ways:
● "Rename" context menu item of the element
● Marking the element and actuating the <F2> functional key
● Marking the element, waiting approx. 1 s, and marking it once again
Afterwards, the new name can be entered.
As long as the renaming process has not been completed by means of the
<Enter key> or marking another element, the old name can be restored by
pressing the <ESC> key.
The system simulator offers the possibility to give the same name to 2 ele‐
ments. I.e. a model can have 2 sheets with identical name and one sheet can
have 2 components with identical name.

Cutting, Copying, Pasting and Deleting Elements
The model explorer allows for the cutting, copying, pasting and deleting of el‐
ements via the context menu or the corresponding shortcuts:
● Cutting: (<CTRL>+<X>)
● Copying: (<CTRL>+<C>)
● Pasting: (<CTRL>+<V>)
● Deleting: (<DEL>)
By means of the "Delete" function, the element marked in the model explorer
together with all subordinate elements that might exist will be deleted after a
confirmation prompt. You can delete all elements except the models.
By means of the "Cut" function, the element marked in the model explorer to‐
gether with all subordinate elements that might exist will be copied to the clip‐
board and deleted at the place of origin. It can then be pasted at the new
destination using the "Paste" function.
By means of the "Copy" function, the element marked in the model explorer
together with all subordinate elements that might exist will be copied to the
clipboard and can then be pasted at the new destination using the "Paste"
function.

The paste operation must always be performed from a superior
element.
● A sheet can be pasted at the model
● A component can only be added to a sheet

Duplicating
Using the Duplicate context menu item, the marked sheet, component or ac‐
cessory object can be duplicated in the model explorer. The new component
is placed in the top left corner of the model view.

Change Element Order
The order of the elements displayed in the model explorer can be changed by
Drag&Drop. To do this, first choose the elements to be moved by selecting it
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with your mouse, for a multi selection hold down the <Ctrl> key while select‐
ing the elements.
After selecting the elements, click the selected element and hold down the
mouse button during moving the selection to the new location. The insert po‐
sition is highlighted by a blue line.

Fig. 4-3: The model explorer support changing the element order by
Drag&Drop

If the insert position is correct, release the mouse button. The element order
is changed now.

Fig. 4-4: Result of changing element order

You can change the selection order position using the up/down
buttons marked in the screenshot above.

You can only change the element order - you can't move an child
element to another parent element.
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4.2.2 Export / Import of Elements
Export

All elements of the model explorer can be exported. When exporting an ele‐
ment, all subordinate elements are exported, as well - if, for example, you ex‐
port a model, all sheets contained therein with all components will be expor‐
ted, as well.
For exporting elements, only 2 steps are necessary:

1. Mark the element, call the context menu by means of the right mouse
button and select the "Export..." menu item

2. Determine the destination directory and the file name in the export dia‐
log and export the element by means of saving

If a model is exported, the system simulator automatically selects the file type
"model file (*.edtmdl)". A model exported in this way can be added at any
time using the "Open model..." function.
If a worksheet is exported, the system simulator automatically selects the file
type "sheet file (*.edtsht)". A sheet exported in this way can be added to any
model at any time using the "Import..." function.
If a component is exported, the system simulator automatically selects the file
type "component file (*.edtcmp)". A component exported in this way can be
added to any model at any time using the "Import..." function.

Import
The context menu command Import allows the adding of models, sheets and
components. Depending on the object the import is startet, different objects
can be imported:
● whole models (*.edtmdl) via the model explorer context menue
● sheets (*.edtsht) via the context menu of a model node
● components (*.edtcmp) via the context menu of a sheet node

1. Mark the model or sheet in the model explorer, call the context menu by
means of the right mouse button and select the "Import..." menu item

2. Select the file with the import data in the dialog and start the import by
means of Open

If the import is started from a model, only sheets can be imported; the file
type is already specified as "sheet file (*.edtsht)".
If the import is started from a sheet, sheets and components can be imported
whereas the file type is pre-set to "component file (*.edtcmp)". If a sheet is
imported, it is added under the currently selected model.

Import and export can be initiated directly from the model view.

4.2.3 Functions for Sheets
Select All

Using the Select All context menu item, all sheets are selected and are thus
available for further processing.

Set as StartUp Sheet
The sheet displayed directly after this model is loaded can be set via the con‐
text menu Set as StartUp Sheet.
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4.2.4 Functions for Components
Select All

Using the Select All context menu item, all components in the sheet of the se‐
lected component are marked and are thus available for further processing.

Edit Properties
Using the Properties context menu item, the properties like material number
and designation can be adjusted. For more information, please refer to chap‐
ter chapter 5.5  "Properties Dialog" on page 70.

Edit Hyperlink
Via the Hyperlink ▶ Edit Hyperlink... context menu item, the marked compo‐
nent or the accessory can be assigned a hyperlink. For more information,
please refer to chapter chapter 5.6  "Hyperlink" on page 75.
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5 Model View
5.1 General

The model view is used for creating and visualizing a model. It presents the
sheets of a model as well as the components contained therein in a graphical
form in a drawing sheet. The required components can be dragged from the
component library to the model view, placed at the desired place and connec‐
ted with each other.
The model view offers the user functions for the visual revision of the model.
The size and position of the components can be changed, free drawing func‐
tions allow for the creation of lines and simple geometrical figures of any col‐
or.

Fig. 5-1: The model view shows the sheets of a mode together with their com‐
ponents and serves the creation and visualization of a model.

5.2 Set-up of a Model
5.2.1 Adding Components

A model consists of components and their connection among each other.
From the library, the components are directly dragged to the model view by
means of Drag&Drop.
After positioning of the component, the latter is marked in the model view and
in the model explorer.
From the library, the components can also be directly dragged to a sheet in
the model explorer whereas they will then be positioned in the top left corner.

5.2.2 Marking Components and Objects
There are several possibilities for marking components and other objects on
the model view.

Marking individual objects in the model view
The most usual one is the positioning of the mouse pointer over the object to
be marked until the mouse pointer turns into an arrow cross.
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Fig. 5-2: Marking of components - The mouse pointer changes into an arrow
cross if the object under it can be marked.

By clicking with the left mouse button, the object can be marked. A marked
object is highlighted by showing the manipulation points and the green center
of rotation. The marked object is moreover highlighted as marked in the mod‐
el explorer.
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Fig. 5-3: The sine function component is marked

Selective marking of several objects
When marking objects using the mouse, keep the <SHIFT> key pressed; in
this way, you can mark any number of objects. The component marked last is
highlighted by means of white manipulation points, the ones marked first by
means of gray points. The marked objects are highlighted as marked in the
model explorer.

Print Bosch Rexroth AG 51/119
Scheme Editor Version 6.3

Model View



Fig. 5-4: Three marked objects. The object marked last has white selection
points, all others have gray ones.

Marking several objects by means of area selection
For an area selection, position the mouse cursor at a free place of the model
view, press the left mouse button, keep it pressed and drag open an area
shown as dashed rectangle. When the area comprises all desired objects, re‐
lease the mouse button. All objects within the dragged open area are marked
and are also highlighted as marked in the model explorer.
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Fig. 5-5: Marking several objects by means of area selection.

Marking in the model explorer
Components and objects can also be marked in the model explorer. A single
object is marked by means of a mouse click, several objects by means of se‐
lective multiple-section (keep the <CTRL> key pressed) or by means of area
selection (<SHIFT> mouse click start of area and <SHIFT> mouse click end
of area).

Fig. 5-6: Marking components in the model explorer
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5.2.3 Connecting Components
Components can be connected by means of their free ports. You can recog‐
nize the free ports of a component by the red squares.
For establishing a connection, firstly place the cursor over the port of the first
component until the cursor changes from the mouse pointer to the connection

establishment cursor .
Now click with the left mouse button in order to access the connection mode -
the mouse pointer then changes over to the connection cursor . If the
mouse pointer is moved to the port of the other component, a connection line
between the port and the current cursor position is drawn automatically.

Fig. 5-7: Establishing a connection - Positioning the mouse pointer over the
port of the other component

If the mouse pointer is positioned over the port of the other component, the
cursor changes from the connection cursor to the connection establishment

cursor . By clicking with the left mouse button, the connection is estab‐
lished and the cursor changes to the normal Windows cursor.

Establishment of the connection can be canceled using the
<ESC> key or the Cancel context menu item.
Alternatively to clicking twice, the connection can also be estab‐
lished by keeping the left mouse button pressed and releasing it
at the target port.
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5.2.4 Connection Network
If the inputs of several components are connected with one output, you talk of
a connection network.
Start establishing the connection by creating a connection line starting at the
input of the new component. Drag this connection line either to one of the two
ports of the already connected components or to any place of the already ex‐
isting connection line between the components. The cursor changes to the

connection establishment cursor  if the connection network can be set up.

Fig. 5-8: Setting up a connection network - Connecting the input of the A/B
converter with the already existing connection line

If the connection network has been set up successfully, this is symbolized by
a connection point on the connection line.
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Fig. 5-9: Connection network set-up

A maximum of four connection lines can be connected to a con‐
nection point.

5.2.5 Change Connection Line Type
A connection line can be adapted to your special needs by formatting it.
The first possibility is to format the connection line free. Select the connection
line and change color, width and dash style using the toolbar icons or the
properties window as shown in the following screenshot:

Fig. 5-10: Free formatting a connection line using the toolbar icons or the prop‐
erties windows
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The second possibility is to assign a predefined line type as shown in the fol‐
lowing screen shot. You can define new line types using the options dialog.
For further informations please check chapter 10.3.4  "Line Types" on page
104.

Fig. 5-11: Assigning predefined formattings for a connection line using the
properties toolwindow

Instead of using the properties window you can use the toolbar icon Line
Type.

Fig. 5-12: Assigning predefined formattings for a connection line using the tool‐
bar icon

5.3 Modifying the Model
5.3.1 Moving Objects

Objects of the model view can be moved using the mouse and the keyboard.
You can move individual objects and several selected objects at the same
time. The designation of components, position number, accessory as well as
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the labels of inputs and outputs that have not been connected yet, can be
moved, as well.

Mouse operation
1. Mark the objects to be moved.
2. Position the mouse pointer over the marked object until the cursor

changes to the arrow cross.
3. Press the left mouse button and keep it pressed until the object has

been moved to the new target position; then release the mouse button.

Objects can also be moved using the right mouse button. When
releasing the button, you can select in a context menu whether
the object is to be moved or copied to this place.

If during moving, you keep the <SHIFT> key pressed, the object
can either only be moved on the vertical or the horizontal axis.

If during moving, you keep the <CTRL> key pressed, a copy of
the object is created at the new position.

Keyboard operation
1. Mark the objects to be moved.
2. Move the objects by means of the arrow keys.

When moving objects using the keyboard, they are moved in
smaller steps if at the same time, you keep the <CTRL> or
<SHIFT> key pressed.

During moving, objects are by default aligned to the grid if the option "Align to
grid" is activated.

5.3.2 Modifying Objects
Rotating & Mirroring

Via the toolbar, selected objects can be mirrored or rotated in 90° steps:

●  Rotate Right

●  Rotate Left

●  Flip Horizontal

●  Flip Vertical
Apart from the fixedly specified 90° rotation intervals, objects can also be ro‐
tated in 15° steps around their center of rotation. If the object does not have a
center of rotation, rotation is not possible.
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Fig. 5-13: An object is rotated around its center of rotation.
For doing so, the mouse pointer must be positioned over the green center of
rotation of the marked object so that it changes to the rotation cursor. After‐
wards, the object can be rotated arbitrarily while keeping the mouse button
pressed.

If during rotation, you keep the <SHIFT> key pressed, the compo‐
nent can be rotated arbitrarily.
If the object is rotated using the right mouse button, a context
menu is offered after releasing the right mouse button. In it, the
rotated object can be copied to the mouse pointer position using
the Copy here menu item; the source object remains unchanged
and is not rotated.

Scaling
Fee scaling
Using the mouse, objects can be scaled via their handles. The handles be‐
come visible by selecting the object. If an object has no handles, it cannot be
scaled.

Fig. 5-14: Scaling an object
For scaling, the mouse pointer must be positioned over a handle and after‐
wards, the left mouse button must be kept pressed. Now, the object can be
scaled to the desired size using the mouse. If the desired size is reached, the
mouse button can be released.
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Scaling is also possible for several marked objects at the same
time.
If during scaling, you keep the <SHIFT> key pressed, only propor‐
tional scaling is possible, in which the side ratios are maintained.
If the object is scaled using the right mouse button, a context
menu is offered after releasing the right mouse button. In it, the
scaled object can be copied to the mouse pointer position using
the Copy here menu item; the source object remains unchanged
and is not scaled.

Size adjustment
The size of objects can be adjusted to the size of other objects. For this pur‐
pose, at least two objects must be selected whereas the object with the refer‐
ence size must be selected last. Via the toolbar, the height, width or the com‐
bination of both of the objects marked first can be adjusted to the reference
object:

●  Adjust Height

●  Adjust Width

●  Adjust Size

5.3.3 Modifying Connection Lines
The course of a connection line can be changed arbitrarily. For this purpose,
you must firstly select the connection line by means of a mouse click. De‐
pending on length and course, the marked connection line will then show its
modification points.

Fig. 5-15: Selected connection line with modification points and the modifica‐
tion cursor.

If the mouse pointer is positioned over one of the modification points, it
changes to the movement cursor. The movement cursor informs the user by
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means of its arrows into which direction the modification point can be moved.
In the screenshot above, the modification points can be arbitrarily moved in
horizontal and vertical direction.
By clicking with the left mouse button and keeping it pressed, modification of
the connection is initiated. A gray connection line shows the future course of
the connection line as soon as the mouse button is released.

A connection line can be newly created by executing the Estab‐
lish New Connection context menu item.
A connection line can be divided into small sections by means of
the Insert Segment context menu function.

5.3.4 Aligning Objects
Grid

The positioning of objects in the model view is simplified by the grid. The grid
is activated by default, the grid space is half the grating width. The grid can

be switched on and off using the  toolbar.
With activated grid, objects can only be positioned according to the grid
space; free positioning at pixel level is only possible by moving objects using
the keyboard.

Guides
Guides simplify the alignment of objects at pixel level. If an object is moved to
an guides, it "gets stuck" at it with the left or right side in case of a vertical
guides or with the top or bottom side in case of a horizontal guides.
Guides can be shown or hidden by means of the context menu item Show/
Hide ▶ Show/Hide Guides.
Creation
For the creation of auxiliary lines, it is imperative that the ruler is visible. It can
be activated via the context menu item Show/Hide ▶ Show/Hide Ruler or by

means of the  toolbar.
1. Position the mouse pointer on the ruler. For a horizontal auxiliary line on

the horizontal ruler, for a vertical one on the vertical ruler.
2. Press the mouse button and keep it pressed.
3. Drag the mouse pointer to the model view. The auxiliary line follows the

current cursor position.
4. Release the mouse button in order to draw the auxiliary line at the cur‐

rent cursor position.
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Fig. 5-16: Creating a vertical auxiliary line (blue) using the vertical ruler.
Movement

1. Position the mouse pointer on a free area of the auxiliary line until the
cursor changes to the movement cursor.

2. Press the mouse button and keep it pressed.
3. Move the auxiliary line to the new position using the mouse.
4. Release the mouse button.

Deletion
An auxiliary line can be deleted by moving it to the ruler or deleting it after
selection using the <DEL> key.

Several auxiliary lines can be moved or deleted simultaneously if
they are selected together using the <SHIFT> key.

Align to Objects
If the align to objects option is active, objects are aligned to the edges of oth‐
er objects if while being moved, they come close to them.

The align to objects option can be activated or deactivated via the  toolbar
or the context menu item Alignment ▶ To objects.
If 2 or more objects are marked, they can be aligned together using the last
marked object. In this connection, the following options are available:

●  Top alignment

●  Vertical center alignment

●  Bottom alignment
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●  Left alignment

●  Horizontal center alignment

●  Right alignment
The alignment functions can be accessed in the toolbar or via the context
menu of one of the marked objects.

Order
If two or more objects take the same place in the model view, the order of the
objects can be changed so that the desired object is in top position. For de‐
termining the order of an object, the latter must be selected first. Afterwards,
the order can be changed using the following icons from the toolbar or the
context menu Order of the object:

●  Bring object to the back

●  Bring object to the fore

●  Bring object one level back

●  Bring object one level fore

5.4 Drawing Objects
5.4.1 General

Apart from components and connection lines, simple drawing objects can be
positioned on the sheet. For drawing, the following elements in the toolbar
are available:

●  Line

●  Polyline

●  Polygon

●  Rectangle

●  Ellipse

●  Ellipse arc

●  Ellipse sector

●  Free text

●  Text box
Like all other objects of the model view, these objects can be marked,
moved, deleted, duplicated and scaled.
By clicking on the icon in the toolbar, creation of the drawing object is started.
The creation can be completed at any time using the <RETURN> key or the
Finish Creation context menu. When creating a polyline or a polygon, the
shortcut <ALT> + <RETURN> (or the context menu item Finish Creation and
Add Point and/or a double click) provides for the finishing incl. the current
point to be placed; without <ALT>, the latter would be rejected.
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The creation can be canceled at any time using the <ESC> key or the Cancel
Creation context menu item of the model view.
In contrast to the components, drawing objects can be formatted via the tool‐
bar:

● Font color

● Line color

●  Fill color)

●  Dash style

●  Line width
Selected drawing objects can be formatted using the properties toolwindow:

Fig. 5-17: Selected drawing objects can be formatted using the properties tool‐
window

Another formatting possibility is the Format dialog that is opened via the con‐
text menu of the marked drawing object. If you want to set the formatting as
standard for all new drawing objects of same type, check the checkbox
Standard for new objects. If text is formatted, the dialog offers additional
pushbuttons for formatting the text.
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Fig. 5-18: Formatting the selected drawing object via the context menu com‐
mand Format...

Alternatively, the formatting pre-settings can be determined separately for
each drawing object via the main menu item Tools ▶ Options... in the option
dialog and there in the area Format Drawing Objects.

Fig. 5-19: You can set the drawing objects formatting in the options dialog.
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5.4.2 Line
The line is defined by 2 points. Using the left mouse button, click once at the
first and once at the second point. Between the first and the second click, the
line is shown as preview. Alternatively, you can also keep the mouse button
pressed while dragging the line; when you finally release it, the line will be
drawn.

A line does not have the typical marking points like an rectangle
has for example. A marked line has one handle at each of its
ends.
If during creation of the line, you keep the SHIFT key pressed, the
line slope is set to 45° steps.

5.4.3 Polyline
A polyline is defined by 3 or more points. The points are set one after the oth‐
er with the left mouse button. The creation of the polyline can be completed
by means of a double-click or the Finish Creation context menu.

If during creation of the line segment, you keep the <SHIFT> key
pressed, the line slope is set to 45° steps.

5.4.4 Polygon
A polygon is defined by 3 or more points. The points are set one after the oth‐
er with the left mouse button. The "smallest" polygon is a triangle. The crea‐
tion of the polygon can be completed by means of a double-click or the Finish
Creation context menu.

If during setting of the polygon points, you keep the <SHIFT> key
pressed, the slope of the polygon sides is set to 45° steps.

5.4.5 Rectangle
A rectangle is a polygon consisting of 4 points in which all angles are exactly
90° and the opposite sides are parallel to each other.
When drawing a rectangle, it is sufficient to determine the two points of a di‐
agonal. The rectangle is automatically drawn so that the sides are parallel to
the edges of the sheet. If the rectangle is to be positioned in a rotated form,
this has to be achieved by a subsequent rotation.

If during creation of the rectangle, you keep the <SHIFT> key
pressed, a square will be drawn.

5.4.6 Ellipse
Similar to the rectangle, the ellipse is defined by setting two points and is to
be understood as "compressed" circle. During creation, the ellipse is de‐
signed so that the two focal points of the ellipse are located on a line parallel
to the horizontal. If the ellipse is to be positioned in a rotated form, this has to
be achieved by a subsequent rotation.

If during creation of the ellipse, you keep the <SHIFT> key press‐
ed, a circle will be drawn.
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5.4.7 Ellipse Arc
The ellipse arc is similar to an ellipse with the difference, that the ellipse arc
is interrupted between the 3 and 6 ó clock position. To change the ellipse arc,
select him and choose the context menu point Edit. The starting point of the
ellipse arc is now marked with an square, the end with an arrow.
Click the square or arrow and hold down the mouse key while moving the
mouse to move the point. Release the mouse key to save the changes. To
interrupt the editing, press the <ESC> key.

If you move the mouse pointer towards the inner area of the el‐
lipse arc during editing, the ellipse arc changes to an ellipse sec‐
tor and vice versa.

5.4.8 Ellipse Sector
The ellipse sector is an ellipse arc with start and end point connected by lines
with the center of the ellipse. See llipse sector for further details.

5.4.9 Free Text
In order to create a free text, it is sufficient to determine the starting point of
the free text. From there, the entered text is written to the right.
The size of the free text is adjusted to the content. There is no automatic line
break as there are no edges - a new line must be created manually using the
Return key.
In the "Format text" dialog that is called via the Format context menu of the
text box or the toolbar, the size, font type and type face as well as the color of
the free text can be changed. The new settings take effect for the whole text
in the free text.

Print Bosch Rexroth AG 67/119
Scheme Editor Version 6.3

Model View



Fig. 5-20: The text properties can be set in the "Format text" dialog
In the dialog, the new settings can be defined as standard for all new text ob‐
jects.
The individual formatting possibilities are also accessible separately via the
toolbar.

5.4.10 Text box
The difference between the text box and the free text is that the size can be
determined irrespective of the content by specifying the size of the field dur‐
ing creation of the text field accordingly or adjusting it subsequently. Thus, an
"extensive" text may be cut off.

5.4.11 Editing Drawing Objects
The drawing objects line, polyline, and polygon can be adjusted subsequently
by moving the points defining them, adding new points or removing points.
There are three possibilities for putting a drawing object into editing mode:
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● Marking the object with a double-click
● Marking the object and selecting Edit from the context menu
For this purpose, the object must be marked once again after marking. Thus,
the handles disappear and the points defining the object become visible.
These points can now be moved or deleted, if applicable, or you can add new
points.
Adding & moving points
The handling of points is explained using a simple line as example:

1. Mark the line by clicking it with the mouse.
2. Put the marked line into the editing mode by another mouse click and

position the mouse pointer at that point of the line at which a new point
is to be added. The mouse pointer changes to precision selection if a
new point can be added. By means of a mouse click or the context
menu Add Point, the new point is created.

3. Position the mouse pointer over the point so that the mouse pointer
changes to the movement cursor. For moving the point, press the left
mouse button and keep it pressed.

4. Move the mouse pointer to the new target position of the point and re‐
lease the mouse button

Fig. 5-21: By adding and moving a point, a simple line becomes a polyline

If when moving the point, you keep the <SHIFT> key pressed, the
point can only be positioned so that the changed line section can
only have 45° steps.
If in the preceding example, editing is completed after point 3, the
newly set point that is exactly on the line is removed again as the
description of the line by the two end points is accurate enough.

Delete point
Individual points of the drawing objects polyline and polygon can be deleted.
You can maximally delete all points but 2 defining one line.
For deleting a point, the object is put into editing mode, the cursor is posi‐
tioned over the point to be deleted and the Delete point context menu item is
selected. Alternatively, you can position the mouse on the point to be deleted
while keeping the <CTRL> key pressed. Over the point, the cursor changes
to an "X". The point is then deleted by means of a mouse click.

If a polygon is reduced to 2 points and later provided with more
points again, this will automatically result in a polygon (closed
form) again and no polyline.

Closing & opening paths
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Using the context menu function Close Path, a polyline (open form) becomes
a polygon (closed form) by drawing a connection line between the first and
the last point set.

Fig. 5-22: Using the close path function, polylines become a polygon
Using the context menu function Open Path, the line between the first and
the last point set is removed.

5.4.12 Insert Graphic
You can insert graphics to the model view using four ways:
● pasting a graphic copied to the clipboard using the shortcut <STRG>

+<V>
● pasting a graphic copied to the clipboard using the main menu com‐

mand Edit ▶ Paste
● pasting a graphic copied to the clipboard using the model view context

menu command Paste
● selecting a graphics file from your file system using the main menu com‐

mand Insert ▶ Graphic...
You can scale, rotate, mirror, bring to front or send to back a graphic as you
are used to with normal drawing objects. You also can add external shortcuts
to graphics.

Fig. 5-23: Pasted graphics can be scaled, rotated, mirrored and brought to
front and sent to back.

Keep in mind that adding many and / or large graphics will increase your proj‐
ect file size and therefore loading and saving time increases.

5.5 Properties Dialog
5.5.1 General

The properties dialog shows the properties of the selected objects in a table.
Depending on the object type, different properties are shown and different
editing possibilities are offered.

Bosch Rexroth AG  Print70/119
Scheme Editor Version 6.3

Model View



Fig. 5-24: The properties dialog shows the properties of an object and allows
for the editing of the properties.

The dialog is accessible via the main menu item View ▶ Properties or the
context menu item Properties of an object.
By selecting an object, the properties are presented, depending on the object
type. If two or more objects are selected, the intersection of the joint proper‐
ties is shown. Editing is effected by clicking into the cell with the mouse and
changing the value.

The desired object can also be directly selected in the properties
dialog, by selecting it using the selection list directly under the di‐
alog title bar.

5.5.2 Properties of Components
The properties dialog of a component shows the following properties:
● Designation - designation of the component
● Hyperlink Address - hyperlink of the component
● Hyperlink Display Text - text to display instead of hyperlink
● Identification code - is shown in the model view
● Designation - relevant for parts list
● Material number - relevant for parts list
● Item number - relevant for parts list
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Fig. 5-25: The properties of a component
The properties can be edited directly in the dialog. The material number can
be selected via a drop-down box.

5.5.3 Properties of Drawing Objects
Drawing objects show the following properties in the properties dialog:
● Fill Color
● Line Color
● Line Width
● Hyperlink Address
● Hyperlink Display Text
● Location X/Y - position of the center (see ruler)
● Size Width/Height - width and height
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Fig. 5-26: Properties of drawing objects

5.5.4 Properties of Accessories
Text objects show the following properties in the properties dialog:
● Caption - designation
● Hyperlink address - hyperlink
● Material number - material number
● Quantity - quantity
● Short text - short text
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Fig. 5-27: Properties of accessories

5.5.5 Properties of Text Objects
Text objects show the following properties in the properties dialog:
● Background Color
● Border Color
● Border Width
● Font - font type and size
● Font Color
● Text Alignment - Text alignment
● Data text - the text that is to be displaced
● Location X/Y - position of the center (see ruler)
● Size Width/Height - width and height
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Fig. 5-28: Properties of text objects

5.6 Hyperlink
5.6.1 General

Any component, any accessory and any graphical object can in each case be
added a hyperlink. This hyperlink may refer to a file or an Internet page.

 CAUTION

The hyperlink only stores the reference to the external source rather than the
external source itself. If you forward the model, it cannot be guaranteed that
the recipient can access the external sources, as well. If you want to make
sure that the recipient can access all external sources, save them in the
same directory as the project file and then forward the whole directory includ‐
ing model and external sources.
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5.6.2 Adding a Hyperlink
For adding or editing a hyperlink, select the context menu item Hyper‐
link ▶ Edit... of the element from the model view or the model explorer.
The hyperlink dialog opens. In it, you can determine on the left side whether
the hyperlink refers to a file or a website by clicking on the corresponding but‐
ton.

Fig. 5-29: The hyperlink dialog
The "File" or "Address:" field contains the actual link to the external source,
either an Internet address like e.g. "http://www.boschrexroth.de" or the link to
a file, e.g. "C:\Projekte\Tank.doc". Use the button ... to search for the file.

5.6.3 Opening a Hyperlink
The hyperlink is opened via the Open hyperlink... context menu item. The
context menu item is only available if a hyperlink is stored.

5.6.4 Deleting a Hyperlink
The hyperlink is deleted via the Delete hyperlink context menu item.

5.7 Model View Handling
5.7.1 Zoom

Using the zoom factor, the presentation of the model view can be enlarged or
reduced. The zoom factor can be set separately for each model view and is
100% by default.
The operating elements relevant for the zoom factor are located:
● in the toolbar
● in the context menu of the model view
● in the bottom right corner of the model view (zoom buttons)
Alternatively, you can change the zoom value at any time by keeping the
<CTRL> key pressed and scrolling the mouse wheel.

Toolbar 

●  Partial Zoom
– Click on the icon, the cursor changes to the selection magnifier
– Drag open an area in the model view
– The zoom factor is selected so that the selected area fills the mod‐

el view (up to max. 1200%).

●  Dynamic Zoom
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– Click on the icon, the cursor changes to the dynamic magnifier
– In the model view, press the left mouse button and keep it pressed
– If the mouse pointer is moved upwards, the view is enlarged, if it is

moved downwards, it is reduced

●  Zoom In - Increases the current zoom value in 25% steps

●  current zoom value and selection possibility pre-defined
zoom values

●  Zoom Out - Decreases the current zoom value in 25% steps

●  Original Size - Resetting the zoom value to 100%

●  Window Height - Zoom value is set so that the complete height of
the model view is shown

●  Window Width - Zoom value is set so that the complete width of the
model view is shown

●  Zooming Whole Page - Zoom value is set so that the complete
model view is shown

Context menu

●  Partial Zoom

●  Dynamic Zoom
● Zooming all objects - Zoom value is selected so that all objects of the

model view are shown simultaneously
Zoom buttons model view

●  Increases the zoom factor in 25% steps

●  Decreases the zoom factor in 25% steps

If the function "  Partial zooming "or "  Dynamic zoom" is ac‐
tive, the model view is in zoom mode. In this mode, only the func‐
tions from the toolbar relevant for zooming are available in the
context menu. In this mode, the model view can be zoomed using
the mouse wheel.

5.7.2 Overview
The overview function  at the lower right border of the model view offers an
overview in case of complex worksheets.
The current model view is shown as miniature. The currently shown area is
visualized by a red rectangle. If the red rectangle is moved by means of the
mouse, the shown area in the model view changes, as well.
The overview mode is quit by selecting any other function or pressing the
<ESC> key.
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Fig. 5-30: In the overview, the whole model view is shown as miniature graph‐
ics. The currently shown area is visualized by a red rectangle. If the
red rectangle is moved by means of the mouse, the section of the
model view changes, as well.

5.7.3 Alignment
If two or more model views are opened, they can be aligned vertically next to
each other or horizontally above each other. The starting point of the action is
the context menu of the tab of the model view that is to be re-aligned.
If the model views are to be shown vertically next to each other, the New Ver‐
tical Tab Group is to be selected, for a horizontal alignment, select New Hori‐
zontal Tab Group.
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Fig. 5-31: The second model view is to be aligned next to the first model view.
After executing the command, the model view is shown next to the first model
view.

Fig. 5-32: The second worksheet is shown vertically next to the first worksheet.
By creating a new vertical or horizontal tab group, a new document window is
created. The currently active document window is the one with the active
model view, which is marked by the name in the tab written in bold. If now,
new model views are opened via the model explorer, they are opened in the
document window with the active model view.

Print Bosch Rexroth AG 79/119
Scheme Editor Version 6.3

Model View



In this way, the document windows can be divided as often as required - the
only limiting factor is clarity. The document window that has just been created
can, for example, firstly be divided horizontally, and then vertically again.

Fig. 5-33: Moving windows...
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Fig. 5-34: The division of the document windows can be nested arbitrarily.
Model views can be moved from one document window into another
one by means of Drag&Drop.

Via their tab, the model views of a document window can be moved from one
document window into another one by means of Drag&Drop. If the last model
view of a document window is moved into another one, the empty document
window will be closed.

5.8 Change Sheet Format
You can change the sheet format used by the model view. Open the sheet
with a double click in the model explorer and select the main menu command
File ▶ Setup sheet.... Now the dialog Setup Sheet opens where you can
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choose a preset format or define your own by selecting the user defined
sheet format.
A second way to change the sheet format is using the properties toolbox. If
the properties toolbox is not displayed, open it via the main
menuView ▶ Properties. You then can change the sheet format in the region
named Layout.
If you want to define a smaller sheet format so components would not lay
anylonger on the sheet, you will be informed and can choose wether to can‐
cel the operation or automatically move the components in the visible area.

Linked Title Block Templates:DANGER

If the sheet is already linked with a title block template, this link will be re‐
moved. Filled text elements of the title block will de deleted. After that the ap‐
plication tries to assign a title block with a matching sheet format.

5.9 Printing
To print a sheet first select it by double-clicking it in the model explorer and
then performing the main menu command File ▶ Print....
Now the standard Windows printer dialog opens where you can select the
printer or configure the printer clicking the button Properties.... Click the but‐
ton OK to print the sheet.

If the format of the sheet is larger than the paper format of the
printer, the sheet will be automatically scaled to the paper format
of the printer. So you can print a DIN A3 sheet on a DIN A4 print‐
er.
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6 Title Block
6.1 General

The title block is a standardized element of a technical drawing. It offers fields
for information on the creator, the scale, the number of sheets, the date of
creation and modification and additional information. The application allows
you to provide each worksheet with a title block.
The title block administration allows for the duplication, modification and crea‐
tion of user-defined title block templates. Using the export and import func‐
tion, title block templates can be exchanged between different installations
and computers.
Changes in a title block template have a direct effect on all sheets that have
been assigned this template.
Changes in the contents of editable fields of an assigned title block are not
affected by changes in the title block template unless the field is deleted or
marked as not editable.

Fig. 6-1: The Title Block Administration allows for the copying, modification
and creation as well as the export and import of title block

6.2 Assigning the Title Block
Via the main menu item Title block ▶ Assign title block... or the correspondent
context menu item of an opened sheet, the current sheet can be assigned a
title block via the dialog "Assign title block".
The dialog shows all title block templates suitable for the present paper size
and alignment of the sheet as symbol or in a table. The standard for the
sheet is DIN A3 landscape format. For this format, the application provides a
title block template.
In order to assign the title block template, select the desired title block tem‐
plate and quit the dialog pressing OK.
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The title block is now shown in light gray in the model view and put behind all
other elements. In case no title block is shown, check if the property Title
block ▶ Show title block is activated.

The application supports the automatic assignment of a title block
template to new sheets according to sheet size and orientation
via the option dialog. For more information, please refer to chap‐
ter 10.4  "Title Block Area" on page 105.

6.3 Showing the Title Block
The "Show title block" property controls whether the title block of the current
sheet is shown in the model view or not. The property is changed via the
main menu item Title block ▶ Show title block or the correspondent context
menu item.

6.4 Editing the Title Block
The title block of the current sheet can be edited using the function title
block ▶ Edit title block from the main menu or the context menu of the model
view.
In edit mode, all the elements shown as editable by the title block can be edi‐
ted. In the supplied Bosch Rexroth title block, this is true for the text fields in
the lower right corner. By double-clicking in the field, you can enter the text.

Fig. 6-2: In edit mode, you can edit the title block of the current sheet
In the properties window, you find the properties for each element of the title
block that have been marked as editable.
Changes in the title block of a sheet only have an effect on the title block of
the current sheet. Changes are accepted immediately.
You can complete the editing using the command Title block ▶ Edit title block.

6.5 Title Block Administration
6.5.1 General

The title block administration can be accessed via the main menu item title
block ▶ title block administration....
The title block administration allows for the creation, deletion, duplication, im‐
port, export and editing of title block templates.
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Fig. 6-3: Title Block Administration

6.5.2 Duplicating
Using the button Duplicate a copy of the title block selected in the list is made
and the name is extended by a preceding "Copy of".

6.5.3 Properties
Using the button Properties the properties dialog of the marked template is
called. In it, the name as well as the description of the title block template can
be edited. In the lower part of the dialog, the sheet format, the width and
height as well as the orientation are shown.

6.5.4 Layout
Using the button Layout... the title block template is shown in the model view
in edit mode. For editing the title block template, close the title block adminis‐
tration using the button OK.
In edit mode, you are able to position any drawing object on the title block
template and thus, using lines, polylines, polygons, rectangles, ellipses, free
text and text fields, create the title block template adjusted to your require‐
ments. Components of the library are not available.
Specialties text fields:
The drawing objects "free text" and "text field" can be enabled via their con‐
text menu item Editable object for subsequent editing. If the title block tem‐
plate is assigned to a sheet, the text there can be changed (see chapter 6.4 
"Editing the Title Block" on page 84).

Changes in the layout of a title block template have an effect on
all assigned title blocks. If, for example, you delete a text field, it
will be deleted in all assigned title block.

6.5.5 Creating a New Template
Using the button New a new title block template is created.
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In the dialog, the "name", the "description", the "sheet format" as well as the
"orientation" are determined.
If a user-defined sheet format is selected, the width and height can be deter‐
mined individually in mm steps.
Using the button OK the new template is transferred to the title block adminis‐
tration and there, using the button Layout it can be designed individually. The
Cancel button cancels the creation of the template.

Fig. 6-4: Dialog for creating a new title block template

6.5.6 Deleting a Template
Using the button Delete the template marked in the title block administration
will be deleted.

 CAUTION

The template will be deleted immediately without confirmation prompt!

6.5.7 Import
To import a title block, click the button Import... and choose the titleblock file
with the file extension *.titleblock to import.

You can import title blocks been created with previous versions of
the application. If you don't have the title block file, open the old
application, export the title block as file and import it with the ac‐
tual version.

6.5.8 Export
To export a title block, click the button Export... and choose a folder and file
name to save your title block file.
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7 Parts List
7.1 General

The parts list shows the components and accessories of a model that have
been used in the form of a list. The parts list is automatically created from the
model data.
The parts list can be provided with an information text and a title and be prin‐
ted, exported or copied to the clipboard. The import of a parts list results in
the automatic creation of a new sheet in the model.

Fig. 7-1: The parts list shows the components and accessories of a model
that have been used in the form of a list

The parts list displays the user defined fields. The fields, their order and the
way similar components are listed can be adapted to the users needs.

7.2 Open
If a model is open, the parts list can be opened via the main menu item
View ▶ Open Parts List.
Alternatively, the parts list can be opened via the context menu item Open
Parts List of the model explorer. The context menu item is available for every
object except for the project node.

If 2 or more models are opened at the same time, the main menu
item View ▶ Parts List will always open the parts list of the model
of which an object has been marked in the model explorer.

7.3 Adding and Removing Elements
The parts list represents the components and accessories available in the
model. In order to add an element to the parts list or to remove it from there,
the element must be added or deleted via the model explorer or the model
view. In this connection, see chapter 5.2  "Set-up of a Model" on page 49and
chapter 5.3  "Modifying the Model" on page 57.

7.4 Changing the Item Number
The item number of the elements shown in the parts list cannot be changed
via the parts list. The change can only be effected via the properties dialog
and only for components - not for accessories. The properties dialog can be
opened via the context menu item Properties of a component from the model
explorer or the model view. For more information, please refer to chapter 5.5 
"Properties Dialog" on page 70.
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7.5 Naming and Information Text
By default, the parts list contains the name of the model and an empty infor‐
mation text. These two properties can be adjusted to your requirements by
editing the fields "Model:" and "Information:" and are output if the list is prin‐
ted and exported.

7.6 Copying the Parts List to the Clipboard
The parts list with model designation and information text can be copied to
the clipboard via the context menu item Copy or the shortcut <CTRL>+<C>
and is thus available for pasting in other applications, e.g. text processing.

When pasting the list make sure that a font type with fixed charac‐
ter length, e.g. Courier, is selected in order to maintain the struc‐
ture of the table.

7.7 Exporting Parts Lists
The parts list can be exported via the context menu item Export or the main
menu item File ▶ Export.
Following export formats are available:
● Microsoft Excel (*.xls)
● Comma Separated Format (*.csv)
● MS DOS Text (*.txt)
● Adobe PDF (*.pdf) (Only exports the default fields of the parts list, also

available via the context menu item Publish as PDF...)
The file name is pre-assigned with the parts list name.
After you have determined the file name and the file type, the export is initi‐
ated using the Save button.

If you want to edit the exported file in an external program and af‐
terwards import it again, make sure that the format lines starting
with # are not changed as otherwise, an import will not be possi‐
ble.

If you don't have Microsoft Excel, you can view the *.xls files with
the free Microsoft Excel Viewer or edit them with the free tool
Calc of the free office software OpenOffice.

7.8 Importing Parts Lists
Via the context menu item Import or the main menu item File ▶ Import, you
can import parts lists in "*.csv" and "*.txt" format that have been exported ear‐
lier or parts lists generated with BRIFO "*.bom".
Via the "File type" selection field, firstly select the desired import format, then
search the file and start the import using the pushbutton Open.
By the import, a new sheet is generated. All elements of the import file are
assigned to this sheet. Components of the library are automatically aligned
on the model view. All accessories are assigned to the accessory folder of
the new sheet.
If during the import, errors occur, they are notified via information dialogs.
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7.9 Print Parts List
The parts list can be printed via the context menu item Print or the main
menu item File ▶ Print. After executing the command, the standard print dia‐
log opens from which the print-out is started by means of the OK button.
Using the context menu item Print Preview... or the main menu item
File ▶ Print Preview..., a preview of the print-out is shown. You can also start
printing from the page view dialog.
Paper format and margings can be configured in the Page Setup dialog,
available via the main menu command File ▶ Printer Settings....

7.10 Cumulated Parts List
The information displayed in the parts list can be displayed cumulative. When
the display is not cumulative, components with the same material number
and designation are shown cumulative and not as single entry. In the Quanti‐
ty column the number of components is totaled. Accessories are not shown
cumulative.

Fig. 7-2: In normal mode each component is shown as single entry

The cumulative view is displayed pressing the button . The normal view

is displayed pressing the button .

Fig. 7-3: In cumulative view mode components with the same material num‐
ber and designation are shown totaled.

If you change the designation of a cumulative shown component using the
properties window, the designation of all components belonging to this cumu‐
lative group are changed.
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In cumulative view mode a column can show the value "-!!!-". This
happens if the components have different data for this field, espe‐
cially if you use user defined fields.

7.11 Filtering Parts List
The visibility of entries in the parts list can be configured and so the parts list
can be filtered. Only entries with a checked visible flag in the column "Visible"
are shown and exported in the filtered view.

Fig. 7-4: Entries without the checked visible flag will not be shown in the fil‐
tered view

The view is filtered clicking the button  and not filtered clicking the button

.

Fig. 7-5: To leave the filtered view click the highlighted button

7.12 Column Configuration
In the Column Configuration dialog you can configure the columns and the
order of the parts list. The dialog is opened using the context menu command
Column Configuration... or by clicking the button highlighted in the screenshot
below.
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Fig. 7-6: Clicking this button opens the Column Configuration dialog

Fig. 7-7: In the Column Configuration dialog you can configure the columns
and the order of the parts list

The column order can be set by selecting a column and moving it up and

down using the buttons  and . The column width can be set in the
field "Width:".
By double-clicking an entry, this entry will be moved to the other side. By
holding down the <Strg> key and selecting entries, you can bring them to the
other side in the order of their selection by pressing the buttons for left and
right.

By pressing the button Reset button in the Column Configuration
dialog, you can reset the column configuration to factory defaults.
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8 User Defined Fields
8.1 General

User defined fields are used to store user defined content to a component.
They can be named individual and shown in the parts list. So the user can
store pricing information, weight or material numbers. User defined fields are
saved in the model so other users work with them if you send them the mod‐
el.
The user can add up to 30 user defined fields. Fields added in the Options
dialog will be assigned automatic if you create a new model. Fields added to
the model will only be available in this model.
Each model component can have a individual content for the user defined
field. If the model is saved or exported and transferred, all fields are available
for other users.

User defined field only store text. If you define a field "price" and
enter a price, this field will be exported as text. If you want to sum
up data from user defined fields, use the excel export of the parts
list (chapter 7.7  "Exporting Parts Lists" on page 88), open the file,
format the column as number and sum it up.

8.2 Pre-Assignment for New Models
If the same set of user defined fields shall be added to new models, add this
field via the option dialog. The option dialog is opened via the main menu
command Tools ▶ Options.... Then click on User Defined Fields on the left.
Now you can edit user defined fields by clicking the grid cells on the right and
entering the field designation.

Fig. 8-1: Using the Options dialog user defined fields can be edited that will
be assigned to new models.

Leave the dialog by clicking the button OK.
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8.3 Add User Defined Fields
If you want to add a user defined field to a model, use the context menu com‐
mand Open User Defined Fields... available at the model node in the model
explorer.

Fig. 8-2: In the User Defined Fields dialog you can add user defined fields
that are only valid for this model

You can add user defined fields in this dialog if you have not assigned al‐
ready 30 fields. This fields will only exist in this model.

8.4 Edit or Remove User Defined Fields
If you want to edit or remove user defined fields from a model, you can do
this using the same dialog you used to add user defined fields. Open the dia‐
log using the context menu command Open User Defined Fields... available
at the model node in the model explorer.
To edit a field, edit the field designation. This change applies immediately to
the model if you leave the dialog using the OK button. The data stored in the
fields will not be changed.
To delete a field, delete the field designation. This change applies immediate‐
ly to the model if you leave the dialog using the OK button. As long as the
model is open, the data stored in this fields will not be deleted, but will not be
shown anymore. If you assign a new field designation, the data stored in this
fields will be shown again. If you save the model, all data stored in user de‐
fined fields without a designation will not be saved and if you load this model
again, the data is not available anymore.
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8.5 Enter Data in User Defined Fields
To enter data in user defined fields, you must select the component in the
model view or the model explorer. If the properties dialog is not visible, show
him using the component context menu command Properties or the main
menu command View ▶ Properties.
You will find the area Fields in the area User Data, marked with number 1 in
following screenshot. If you can't see the area Fields, open the area User Da‐
ta by clicking the small triangle beside User Data.

Fig. 8-3: User Defined Fields are filled with data in the Properties Dialog if the
component is selected

If you click the field Fields once, the small button ... appears at the end of the
field, marked with the number 2 in the screenshot above. If you click this but‐
ton a dialog opens where you can edit data to the user defined fields.
If you have opened the area Fields, all user defined fields and their content
will be display below. Now you can edit the user defined field data by clicking
the user defined field and entering data. Changes are applied if you press
<Enter> and discarded if you press <Esc>.

8.6 Parts List
Data stored in the user defined fields can be displayed in the parts list and
can be exported there.
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Fig. 8-4: Die Daten der benutzerdefinierten Felder stehen der Stückliste zur
Verfügung und können dort angezeigt und exportiert werden.

If the user defined fields are not shown, you can configure the displayed col‐
umns by clicking the configuration button highlighted in the screenshot
above. For more informations regarding column configuration refer to chapter
7.12  "Column Configuration" on page 90, for details regarding the parts list
to chapter 7  "Parts List" on page 87.
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9 Accessory Handling
9.1 General

Via the library component accessory, any number of accessories - e.g.
screws, screw connections, nameplates, base plates, etc. - can be added to
a model, sheet or component. The accessories are listed in the parts list and
in the model explorer, however not shown in the model view.

Fig. 9-1: Accessories can be assigned to the model, the sheet or the compo‐
nent. They are listed in the parts list and in the model explorer, how‐
ever not shown in the model view.

If a component or sheet is removed, all related accessories will be removed,
as well.

9.2 Adding Accessories
The accessory is added from the library by means of Drag&Drop. The acces‐
sory can be added at the following points:
● Model view:

– Component
– Sheet

● Model explorer:
– Component
– Sheet
– Model
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9.3 Configuring Accessories
Any accessory can be configured via the properties dialog. In this way, name,
material number, short text and quantity of the accessory can be determined.
For this purpose, the accessory must be selected via the model explorer or
the selection list of the properties dialog. If the properties dialog is not
opened, yet, it can be opened via the Properties context menu item of the ac‐
cessory.

Fig. 9-2: The accessory is configured via the properties dialog.
For more information on the properties dialog, please refer to chapter 5.5 
"Properties Dialog" on page 70.

9.4 Searching Accessories
Configuration of the accessories - particularly the correct determination of the
material number - can be simplified by means of the accessory search. The
accessory search searches the supplied list of accessories for material num‐
ber or designation. The search result can be accepted as new configuration
of the accessory and further processed.
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Fig. 9-3: Search for accessory

1. Select component
2. In Properties toolwindow, click into filed "Material Designation" or "Mate‐

rial Number" and on button .... Or use the Edit... context menu entry of
the component.

3. You can either edit material number, designation and quantity in area 3
or ...

4. You can search for a new accessory. First select the search criteria
5. Enter the search term
6. Select a search result and edit designation and quantity in area 3. Click

on OK.
Click on Cancel to cancel the operation.

The accessory search dialog can also be opened via the context
menu item Edit of the accessory in the model explorer.

9.5 Presentation of the Accessory in the Parts List
In order to show the accessories in the parts list, no interaction on the part of
the user is necessary. Like normal components, the accessories are auto‐
matically shown in the parts list. In contrast to components, accessories are
not automatically shown as summation in order to ensure assign ability to the
corresponding components, sheets and models. Components are only sum‐
med up if they have the same accessories.
Display of the accessories in case of components:
In the list view, these accessories are shown directly under the component to
which they have been added. The accessories are, however, not assigned an
item number.
Display of the accessories in case of sheets:
The accessories of all sheets of a model are listed in the list view at the end
of the list without item number and assignment to the sheet.

Print Bosch Rexroth AG 99/119
Scheme Editor Version 6.3

Accessory Handling



Display of the accessories of the model:
These accessories are shown at the beginning of the list without item num‐
ber.

Fig. 9-4: Presentation of the accessory in the parts list

9.6 Exporting and Importing Accessories
Accessories cannot be exported or imported separately. If, however, a com‐
ponent, a sheet or a model is exported, all related accessories will be expor‐
ted, as well. In a subsequent import, the accessories will be imported, as
well.

9.7 Deleting Accessories
Accessories can be deleted separately via the model explorer. For this pur‐
pose, mark the accessory to be deleted and press the <DEL> key or select
the Delete context menu item of the accessory and confirm the following con‐
firmation prompt with OK.
If a component, a sheet or the whole model is deleted, all subordinate acces‐
sories will be automatically deleted, as well.
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10 Option Dialog
10.1 General

In the option dialog, certain program options can be set. These include the
user interface language, the layout of the different areas of the application,
the behavior of models and the formatting pre-settings for drawing objects.
You can select the individual areas via the tree view on the left side. Using
the button Accept the settings of the selected area are saved and applied.
Via Reset the settings for the selected area are reset to works settings. If the
button Cancel is pressed, all changes that have not been accepted, yet, will
be rejected and the dialog will be closed. OK saves all changes and closes
the dialog.

Fig. 10-1: Settings for language, formats and im- and exports are done in the
options dialog
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10.2 Environment/General Area

Fig. 10-2: Area Environment/General
Following settings can be made in this area:
● User interface language - changes need a application restart
● Save and restore layout during application shutdown and start - saves

and restores window and tool window size and layout
● Reset Toolbars - resets toolbar layout to factory settings
● Reset Tool Windows - resets tool windows to factory settings
● Reset Library - resets Symbol Library to factory settings. Attention - this

will delete all Libraries that are not shipped and installed together with
Scheme Editor setup

10.3 Model View Area
10.3.1 General/Sheet Format

Fig. 10-3: Area General/Sheet format
Sheet formats are managed in the area general. The selected sheet format in
the field sheet format is used as default paper format for new sheets.
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Defining a new sheet format:
● click button Manage Sheet Formats...
● click button New...
● enter a designation and the width and height in mm for the new sheet

format. Confirm inputs clicking the button OK
● You have defined a new sheet format. Leave the dialog by clicking OK

Fig. 10-4: Defining a new sheet format
To determine what sheet format is used for a sheet, double-click the sheet in
the model explorer so it is opened and selected. In main menu, select com‐
mand File ▶ Setup Sheet.... Now the dialog Setup Sheet opens where you
can see and set the sheet format.

If you transfer a model with an own user defined sheet format to
another user, the sheet height and width is stored in the model,
the sheet name is not stored in the model and will be displayed as
user defined.

10.3.2 DWG/DXF Import Area
In the DWG import area, settings can be made that are considered when im‐
porting DWG files to the model view.

Fig. 10-5: DWG/DXF Import

10.3.3 DWG/DXF Export Area
In the DWG/DXF export area, settings can be made that are considered
when exporting DWG/DXF files.
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Fig. 10-6: DWG/DXF Export

10.3.4 Line Types
If a line type is assigned to a connection line, all line type format settings are
transferred to the connection line.
You can create, edit and delete line types in the line types dialog and you can
define the format settings for standard connection lines.

Fig. 10-7: Line types options
Click the Create... button to create a new line type. Enter a new name for the
line type and choose color, dash style and width and control the format set‐
tings in the preview windows. The line type is created if you click the OK but‐
ton.
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The format settings for a new connection line are defined in the Default Set‐
tings area of the dialog. First choose a line type to get basic format settings
and then change color, dash style and width to your needs - the original line
type is not changed by this settings.

10.4 Title Block Area
It is determined via the "Automatically assign a title block template to a new
sheet" checkbox that a newly created sheet is automatically assigned a title
block template.
Each sheet size and orientation can be assigned an own title block template.
The assignment is performed via the "Link title block template" dialog that is
called via the Add... button.

Fig. 10-8: Automatic assignment of a title block template for a new sheet
The dialog allows for the search for existing title block templates using the
properties "description", "width" and "height" as well as "orientation".
By selecting the description user-defined, you can specify user-defined pa‐
rameters in the fields width and height.
The list of the title block templates shows all hits. By means of the "Presenta‐
tion" selection box, you can change between a list view with details or a sym‐
bol view with title block preview.
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Fig. 10-9: Linking title block templates
Select the desired title block template and confirm the dialog with OK in order
to complete the assignment.

For more information regarding the title block topic please refer to
chapter 6  "Title Block" on page 83.

10.5 Option Dialog
In the formatting area, the pre-setting of the drawing objects can be made::
● Color
● Width
● Dash style
● Filling Color (not available for lines)
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Fig. 10-10: Formatting settings for line, polyline, polygon, rectangle and ellipse

For the drawing objects free text and text field, there are the following, addi‐
tional setting possibilities:
● Font
● Font color
● Font style
● Font size
● Orientation
● Color, dash style and width of the border line
● Fill color of the border line area
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Fig. 10-11: Formatting settings for text field and free text

10.6 User Defined Fields Area
The option dialog for user defined fields allows the definition of user defined
fields that will be assigned to new fields. For further informations see chapter
8  "User Defined Fields" on page 93.

Fig. 10-12: The option dialog for user defined fields allows the definition of user
defined fields that will be assigned to new fields
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11 Information Dialog
11.1 General

The information dialog can be called via the main menu item Help ▶ About
Scheme Editor.
In the upper area of the dialog, the product version as well as the version of
the technical components is shown.
Using the button System Information will open the dialog with system infor‐
mation which is helpful in case you contact our support.
Clicking the link Open Source Software will open a dialog showing all open
source components used in the Scheme Editor.
If you need further information or want to contact our support, click on the
mail link.
The lower area contains the copyright information.

Fig. 11-1: The information dialog shows version number, contact addresses
and the copyright information

11.2 System Information
The System information buttons opens the system information dialog show‐
ing detailed information about the system and the application. In case of
problems with the application, it serves problem reporting purposes. After
clicking on the button, extensive system information is first of all gathered - a
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progress bar provides information on the progress. In the dialog, the system
information can be pasted in a new e-mail by means of the Send e-mail...
button; this e-mail can be processed individually and afterwards sent to the
support for problem solution.

Fig. 11-2: The system information dialog gathers any and all relevant system
information required for the problem solution.

The Copy all button copies the whole information to the clipboard, the Export
all... button allows for the export of the system information to a file.
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12 Symbol Modeling Tool
12.1 General

The Symbol Modeling Tool is installed together with the Scheme Editor. It is
used to edit and create symbols for the Scheme Editor.
Symboles can be exported from Scheme Editor and opened and edited with
the Symbol Modeling Tool. After that the symbols can imported into the
Scheme Editor.

Fig. 12-1: The Symbol Modeling Tool is used to create and edit symbols for the
Scheme Editor

The Symbol Modeling Tool supports DWG, DXF and SVG import. This ena‐
bles you to quickly convert existing drawings in Scheme Editor symbols.

12.2 Create New Symbol
To create a new symbol, just start the Symbol Modeling Tool or click on the
left button in the main menu and select New.
Draw you new symbol using the existing drawing elements and formatting op‐
tions. You find all this in the Draw ribbon .
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Fig. 12-2: New symbols can be drawn with the Symbol Modeling Tool
After that add the connection ports and edit their designation and orientation
using the ribbon Ports.
Select the proper connection port and place it at the symbol. Pay attention
that the connection ports lay on the grid to avoid bucklings in the connection
line.
The port orientation defines the direction of the port designation and the di‐
rectionn of the connection line in Scheme Editor.
The port index designation and position can be also edited.
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Fig. 12-3: Connection Ports are defined using the ribbon Ports
Before you save the symbol, you must define the symbol properties:
● Symbol designation for DE and EN - search criteria and display name in

the library
● Symbol name - technical name / ID of the symbol, search criteria
● Material number - edit material numbers using additional dialog, select

default material number if you want that this number is used every time
you Drag & Drop this symbol to your model
Identification code
Hyperlink

Fig. 12-4: Edit symbol properties and material numbers
After that you can save your symbol and import it in Scheme Editor.
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12.3 Import DWG, DXF and SVG 
A symbol can also be generated by importing an existing drawing in DWG,
DXF or SVG format.
To import an existing drawing, use the main menu commmandFile ▶ Import
and select the desired file format
The drawing will be imported and selected. Now set the line width for all ele‐
ments to 0,2.
In the next step you need to scale the object using its drawing points so that
the connection will fit on the grid. You can fine tune the position using <Ctrl>
+<Arrow Keys>. Use the view zooming function to check the exact position.
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Fig. 12-5: Scale and place the drawing so the connection points will fit to the
grid

Now add the ports and edit the symbol properties before you save the symbol
and import it in Scheme Editor.
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